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Preface

This documentation is organized under the following headings:

Introduction

What is Predict Description and Generation? Restrictions and benefits.

Elements of Predict Description
and Generation

Context menus and commands that are available in NaturalONE when
this component has been installed.

Getting Started with Predict
Description and Generation

How to show the view that is required for working with documentation
objects. Information on preferences and navigation commands.

Invoking an Overview of All
Documentation Objects

How to display the documentation objects for a specific connection.
How to filter or find the documentation objects, how to display the
properties for the nodes, and how to refresh the tree.

Managing Natural Objects

How to create documentation objects by redocumenting Natural objects
or by opening the description for a Natural object or library. How to
find out whether a Natural object or library has already been
documented by displaying its description.

Managing Documentation Objects

Information on the object type-specific content editors. Information
on the locking mechanism. How to modify, rename or purge
documentation objects.

Managing Associations and Links

How to link/unlink objects, and how to modify the attributes of a link.

Managing External Objects

How to generate external objects from documentation objects, and
how to administer external objects (refresh, disconnect and purge).

Managing Predict Components

How to simplify continuous integration and deployment, e.g. Adabas
DDMs, files (FDTs) etc. based on Predict definitions.

Notes:

B

1. Reference documentation is provided separately. See Predefined Object Types in Predict.

in External Objects in Predict.

Certain features concerning external objects (generation and administration) are documented

This documentation assumes that at least Predict Version 4.6.1 is installed on the server you

are connecting to. If you use an older version of Predict, the contents and design of windows,
tabs and dialogs may differ from those displayed in this documentation.




vi
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

Product Training

You can find helpful product training material on our Learning Portal at https://learn.software-

ag.com.

Tech Community

You can collaborate with Software GmbH experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:

Predict Description and Generation
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About this Documentation

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software GmbH news and announcements.

® Explore our communities.

® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software GmbH resources.

Product Support

Support for Software GmbH products is provided to licensed customers via our Empower Portal
at https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

Predict Description and Generation 3
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Release Notes

New Features

Management of Predict components in NaturalONE
It is now possible manage Predict components in Natural ONE. See Managing Predict Compon-
ents for details.
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Introduction

What is Predict Description and Generation?

Predict Description and Generation is available as an optional component for Natural ONE.

With Predict Description and Generation, you can document Natural sources in Predict via Nat-
uralONE, and you can manipulate and retrieve data stored by Predict on the server. Predict De-
scription and Generation works in the Natural Server Mode.

| Note: When you establish a connection to a Natural server environment on a Linux or

Windows platform where Predict is installed, you can use the predefined PRFPARM session
parameter.

In addition, you can use Predict Description and Generation to manage external objects (generation
and administration).

Restrictions

Some functions are only available in Predict.

In this version of Predict Description and Generation, it is not possible to create new object types.
This is currently only possible with Predict.

In this version of Predict Description and Generation, generation and incorporation is supported
for Adabas and DB2 structures. This includes generation and incorporation of the following:

® Adabas databases (incorporation only),

" Adabeas files,

= DB2 databases,

® DB2 procedures/functions (generation only),
" DB2 storagegroups,

® DB2 tablespaces,

= DB2 tables/views,

* DDM:s for Natural (generation only),

" activation of automatic processing rules (generation only).

Generation and incorporation of other external objects is currently only possible with Predict.

8 Predict Description and Generation



Introduction

Benefits

With Predict Description and Generation, locking of documentation objects takes place. This feature
is not supported in Predict. See Locking of Documentation Objects for further details.

Setting Up a Predict Environment

You install the optional Predict Description and Generation component of NaturalONE using the
Software AG Installer.

If you want to use the optional Predict Description and Generation component of Natural ONE,
Predict Version 8.4.1 or above must be installed on the server and the Natural profile parameter
FDIC on the server must specify a valid Predict file.

You can check this directly from within NaturalONE. To do so, proceed as follows:
1. Map the appropriate Natural server in the Natural Server view (see Mapping a Natural Environ-

ment in Using Natural ONE).

2. Open the properties for the mapped Natural server (see System Information for a Natural Envir-
onment in Using Natural ONE).

3. View the product information (SYSPROD) and the system files (SYSPROF).
When Predict Description and Generation has been installed and when the current context (that

is, the selected item in the Natural Server view) allows it, an additional Predict Description and
Generation menu is available in the context menu.

Predict Description and Generation 9
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Elements of Predict Description and Generation
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Elements of Predict Description and Generation

When Predict Description and Generation has been installed, additional elements are available in
NaturalONE:

Context Menus

When the current context (that is, the selected item) allows it, the commands described in the
section Commands can be chosen from a Predict Description and Generation context menu.

=F Map
¥4 Unmap

E:| Predict Description and Generation r

Properties

A context menu also contains further component-specific commands such as Open, Filter and
Delete. These commands are described later in this documentation.

> To invoke a context menu

1  Select the item for which you want to invoke a context menu.

2 Click the right mouse button.
Or:
Press SHIFT+F10.
Or:
Press the menu key on your keyboard.

The context menu appears and you can now choose the required command.

12 Predict Description and Generation



Elements of Predict Description and Generation

Commands

When Predict Description and Generation has been installed and you have defined a connection
to a server where Predict has been installed, the following commands are available for Natural
objects (displayed in the Natural Server view or in the Project Explorer view or in a Natural Editor
in NaturalONE):

= On Natural Server Connections

Predict Description and Generation 13



Elements of Predict Description and Generation

= On Natural Objects

On Natural Server Connections

oo [aw

-=H daeh-7316
= ibmz-4722
‘nﬁ User Libraries
--1-—'5 Swetern Libraries
k) DOMs
= ibm2-4722 Fdic=(130, 156
= ibm2-7307
-=H ibmi2-7307 Fdic=(150, 156)
= b2-7307 Fdic=(150,250)
-2 5i16-4733

=2 Al Obhjects
-, Find Objects

Predict Description and Generation

Properties , ,
P ‘51" Schema Generation Wizard
Schema Incorporation Wizard
Command Using this command, you can ...
All Objects Invoke a tree view window containing all documentation objects.
Find Objects Search for specific documentation objects.

Schema Generation Wizard |Invoke the Wizard to generate Schemas into external systems.

Schema Incorporation Wizard |Invoke the Wizard to incorporate Schemas from external systems.

On Natural Objects

Command Using this command, you can ...

Redocument / Redocument |Create documentation objects for the selected Natural object. See
Objects Redocumenting Natural Objects for details. This command is not available
for DDMs and Libraries in the Navigator view.

Display Description Invoke a separate window containing a read-only description of the selected
object. See Managing Natural Objects for further details.

Open Description Invoke a separate window containing a modifiable description of the selected
object. See Managing Natural Objects for further details.
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Elements of Predict Description and Generation

Command Using this command, you can ...
Report Description Invoke a separate window containing a description of the selected object as
a plain text report. See Managing Natural Objects for further details.

Predict Description and Generation 15



16



5 Getting Started with Predict Description and Generation

B Setting the PrefErENCES ...cooiiieie e
B EN@DING TTACING ...ttt ettt ettt e oottt e e e e e ettt e e e e e et e e e e e e e

17



Getting Started with Predict Description and Generation

Setting the Preferences

~ To set the preferences

1  From the Window menu, choose Preferences.

2 Inthetree of the resulting window, expand the Software AG node and select Predict Descrip-
tion and Generation.

| P

o0

type filter text | Predict Description and Generation P -

Javaseript . General Settings for Predict
JSON

Predict Trace Options
Language Servers
Maven Trace enabled

Mylyn Level SEVERE
Oemph
Plug-in Development
Remote Systems
Report Design
Run/Debug
Server
v Software AG
Ajax Developer

Business Services
Code Generation
Construct

EntirgX

Matural

Predict Description a
Request Document
Testing

UDD| Registries

. Web Services Sln‘ltk) v Restore Defaults Apply

N (@)
£ el B8 =/ Apply and Close Cancel

3 Modify the desired values.
4 Choose the OK button.
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Getting Started with Predict Description and Generation

Enabling Tracing

You can enable tracing to troubleshoot configuration and connection issues. This option records
what is happening internally within the component.

~ To enable tracing

1  Activate the Enable tracing check box.

2 Select the desired trace level from the Trace level spin box.

The following trace levels can be set.

Level Description

SEVERE |The SEVERE level designates error events that might still allow the application to continue
running or will presumably lead the application to abort.

WARNING|The WARNING level designates potentially harmful situations.

INFO The INFO level designates informational messages that highlight the progress of the
application at coarse-grained level.

CONFIG |The CONFIG level designates configuration issues.

FINE The FINE level designates fine-grained informational events that are most useful to debug
an application.

FINER |The FINER level designates finer-grained informational events than the FINE level.

FINEST |The FINEST level designates all informational events regarding trace.

Predict Description and Generation 19



Getting Started with Predict Description and Generation

ﬂ Preferences ] Y

| type filter text Predict Description and Generation = - §

Remote Sy#tms & General Settings for Predict
» Report Design

Run/Debug Predict Trace Options
Server [4] Trace enabled

~ Software AG

Ajax Developer
Business Services WARNING
Code Generation INFO

» Construct
> Entie FINER
» Matural FINEST
Predict Description ar
Request Document
Testing

UDDI Registries

Web Services Stack
Team

o

W

"

W

W

» Terminal
TextMate
Validation

> Web

Web Services

: ML ™ b Restore Defaults [ Apply

il Msg ) Tasks [o| Details Bk BB B

L

W

Runtime information will now be provided in the standard Eclipse Console view.

> To show the Console view

s From the Window menu, choose Show View > Other > General > Console.

The Console view appears.

ﬁiiﬂiii ﬁ i E_-,Prublems}@Tasks} 5" Q.'—E| ma El - Fﬁ - = EW

Predick Description and Generation

.ﬂ »

For information on how to use this view, see the Eclipse documentation.
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Invoking an Overview of All Documentation Objects

Displaying the Documentation Objects for a Specific Connection

~ To invoke the tree view window containing all documentation objects

s From the context menu of a server connection in the Natural Server view, choose Predict
Description and Generation > All Objects.

The tree view window appears. It contains the top-level node Documentation Objects.

When you expand the Documentation Objects node, nodes for all object types (predefined object
types and user-defined object types) are shown. The object types to be shown can be reduced using
a filter; see Defining the Object Types to be Shown.

When you expand the node for an object type, the defined documentation objects of that type are
shown. You can also apply a filter to an object type, for example, to show only databases of type
Adabas; see Applying a Filter to an Object Type.

When you expand the node for a documentation object, nodes for all active associations of that
object are shown. Some of these nodes can be expanded further.

22 Predict Description and Generation



Invoking an Overview of All Documentation Objects

=

= [ ocurnentation Obj

l.- -
|';_] Predict Description and Generaki 25

ecks
Database
Dataspace
Extract

File

File relation
Interface
kewword
Library structure
Methiod
Metwork,

Mode
Packagelist
Program
Property
Repart lisking
Server
Skoragespace
Svskem

Trigger

User
Werification
Wirkual machine

The following icons are shown for the nodes in the tree:

z® Top-level node for all documentation objects

&%  Object type

Mmoo

Link

Filtered object type

Dummy (blue border with blue content)

Placeholder (red)

Documentation object (brown border with light blue content)

Predict Description and Generation
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Invoking an Overview of All Documentation Objects

'_:,:q:' Filtered link

w-, External Objects

Filtering Documentation Objects

Using a filter, you can reduce the number of items that are shown in the tree. The filter criteria are
saved individually for each user.

The following topics are covered below:

= Defining the Object Types to be Shown
= Applying a Filter to an Object Type

Defining the Object Types to be Shown

You can reduce the number of predefined and user-defined object types. For example, you can
define a filter which only shows your own user-defined objects.

~ To define the object types to be shown

1  In the tree, select the node Documentation Objects.

2 Invoke the context menu and choose Display Filter.

The Select Filter dialog box appears. The object types that are currently shown are selected.
For example:
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Invoking an Overview of All Documentation Objects

& select Filter

Choose Filter:

[ <=7_EL_Extension A
Database

[ataspace

Emploves

Extrack

File

File relation

Interface

kewword

Library struckure

Methiod

Mekwork,

Mode

Packagelist

Prograrn

Property

Fepart lisking

Server —_—
Skoragespace

Syskem

Trigger LI

Select Al | Deselect Fl.lll

EEREREEEEEEEREEEERERECOR

[ Turn off Filker

(0] 4 I Cancel |

3  Select the object types that are to be shown, and/or deselect the object types that are not to be
shown. You can use the Select All or Deselect All button to select or deselect all displayed
objects types.

When you select the Turn off filter check box, your filter is not applied. This is useful if you
want to deactivate your filter temporarily.

4  Choose the OK button.

The content of the tree changes. The tree now only shows the object types that you have
defined in your filter.

Predict Description and Generation 25



Invoking an Overview of All Documentation Objects

Applying a Filter to an Object Type

You can reduce the number of objects that are shown for a specific object type. For example, you
can define a filter for the predefined object type Database which only shows the databases of type
Adabas. When a filter has been applied to an object type, the following icon is shown in the tree:

i

N

~ To apply a filter to an object type

1 Select the object type to which you want to apply a filter (for example, the predefined object
type Database).

2 Invoke the context menu and choose Display Filter.
The Filter dialog box appears. The type(s) that are currently shown are listed in the text box

of the Type drop-down list box (only as much as fit in the text box). Example for the object
type Database:

26 Predict Description and Generation



Invoking an Overview of All Documentation Objects

_I-' 2et Filter for [Program] _ O] x|

Identification |g:|ntent5 | fidvanced I Object Type Specific |

Ohbject bvpe: IF'ru:ugram »| Choose...
Tvpe: I* | Choose...

Types are separated by a semicalon

Mame: |l Choose. .. |

Mames are separated by a semicolon (* = any string)

lamespace: I

[ Turn off filker [ Apply Filker bo links

(7] (] o ancel

When you select the Turn off filter check box, your filter is not applied. This is useful if you
want to deactivate your filter temporarily.

When you select the Apply filter to links check box, your filter is also applied to links.

3  If you only want to define a filter for a single type, select the type from the Type drop-down
list box.

Or:

If you want to define a filter for more than one type, click the Choose button which is shown
next to the Type drop-down list box.

The Types dialog box appears. The types that are currently shown are selected. Example for
the object type Database:

Predict Description and Generation 27



Invoking an Overview of All Documentation Objects

Types: |
Choose Type:

adabas Database
O adabas 0 Handler
O conceptual Database
DBZ Database

O Gen. 5oL Handler
O other Handler

O 1rgres Handler

O oracle Handler

[ Entire System Server
Adabas SQL Handler
D S0L Server

[ Target Mode

O vsamM Handler

O 1nformix Handler

O svbase Handler

Select Al | Deselect Fl.lll

(0] 4 I Zancel |

Select the types that are to be shown, and/or deselect the types that are not to be shown. You
can use the Select All or Deselect All button to select or deselect all types.

Choose the OK button to close the Types dialog box. In the Filter dialog box, the selected
types (as much as fit in the text box) are now shown in the text box of the Type drop-down
list box.

If you want to further restrict your filter selection to object types with a specific name, you
can enter the name or the first character(s) of the name followed by an asterisk (*) in the Name
text box.

Or:

If you want to define a filter for more than one name, click the Choose button which is shown
next to the Name text box.

The Names box appears.

Predict Description and Generation



Invoking an Overview of All Documentation Objects

Gvames  H|

Marnes

QK I Zancel

Enter the names or the first character(s) of the name(s) followed by an asterisk (*). Choose the
OK button to close the Names dialog box. In the Filter dialog box, the defined names (as
much as fit in the text box) are now shown in the Name text box.

5  You can specify further filter criteria on the different tabs of the Filter dialog box. The same
tabs are used in the Find Documentation Objects dialog box. See Finding Documentation
Objects for information on these tabs.

6  When you have defined all filter criteria, choose the OK button to close the Filter dialog box.

When the node for the selected object type is currently open in the tree, you can see that its
contents changes. Only nodes for the types that you have selected are now shown.
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Invoking an Overview of All Documentation Objects

Finding Documentation Objects

You can search for objects of a given type. The found objects are shown in a list view window.

~ To find an object

1  From the Natural Server connection choose Predict Description and Generation > Find Ob-
jects.

Or:

In the Predict Description and Generation view select either the top node Documentation
Objects or a documentation object and from the context menu, choose Find Objects.

The Find Documentation Objects dialog box appears. This dialog box provides several tabs
(some of these tabs are only shown for specific object types):

® Identification

® Contents

Advanced

Object Type Specific
2 Specify your search criteria on the different tabs as described below.

3  Click the OK button.

The Find Documentation Objects dialog box is closed and all found objects are shown in a
list view window. Example:
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Invoking an Overview of All Documentation Objects

98 [D="ELEMENT” FROM-DATE=" 00:00" 53 =0
Mame - | Tvpe | fdded | Modifies -
ARTNAME IMS Segment Field  2004-09-10 14:19
ARTMNAME IMS Seq. layout... 2005-04-01 09:28
ARTNAME IMS Userview Fi... 2005-04-01 09:33
ARTHR, IMS Segment Field  2004-09-10 14:19
ARTHR, IMS Seq. layout... 2005-04-01 09:28 2005-0r
ARTHR, IMS Userview Fi... 2005-04-01 09:33
ARTPRIZE IMS Segment Field  2004-09-10 14:19
ARTPRIZE IMS Seq. layout... 2005-04-01 09:28
ARTPRIZE IMS Userview Fi... 2005-04-01 09:33
ARTH IMS Segment Field  2004-09-10 14:19
ARTH IMS Seq. layout... 2005-04-01 09:28
ARTH IMS Userview Fi... 2005-04-01 09:33
DM IMS Seq. layout,., 2005-04-01 09:28 s
DY IMS Seq. layout... 2005-04-01 09:28
DM IMS Seq. layout... 2005-04-01 09:23
GRP_TY_CD DB2 Table Field  2009-03-10 13:29
OAT_BATCH_TC... DB2 TableField  2009-03-10 13:29
OAT_INQUIRY_... DB2 TableField  2009-03-10 13:29
OAT_LINEL_AC... DB2TableField  2009-03-10 13:29
OAT_MAIN_TRA... DB2 TableField  2009-03-10 13:29
OAT_PRD_END_DT DE2 Table Field  2009-03-10 13:29
OAT_PRD_TY DB2 Table Field ~ 2009-03-10 13:29
OAT_REF_NO DB2 Table Field  2009-03-10 13:29 v
0 | 4

You can manage the found objects using the context menu. For example, you can open, display
or create a report of an object.

You can print the list view content (or a selection of it) using the standard Eclipse functions:

From the File menu choose Print... or click the == button.

When no objects meeting the specified search criteria are found, the above window is empty.
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Invoking an Overview of All Documentation Objects

Identification

All available object types are provided in a drop-down list box .
Multiple objects can be selected using the Choose button.

When a documentation object was selected before issuing the Find Objects command, the object
type and, if appropriate, type of the selected documentation object are automatically preselected.

_" Find Documentation Objects [Field]

Identification | Conkents I &dvanced I bject Type Specific I

Ohiject bype: IFiell:I j Zhoose, ..
Type: I[DBE Table Field, Adabas File Field, DBZ View Field, adabas Cluster Tal:uj Choose, ..

Types are separated by a semicolan

Mame: | Choose. .. |

Mames are separated by a semicolon (* = any string)

Mamespace: I

(7] (a4 Cancel
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Option

Description

Obiject type

The object type to which the find function applies.

Type

Only available for documentation objects with different types.

= If you only want to find a single type, select the type from the Type drop-down list box.
An asterisk (*) in this drop-down list box means that all types of the selected object type
will be found.

= If you want to find more than one type, click the Choose button which is shown next to the
Type drop-down list box. The Types dialog box appears. See the example below.

Name

If you know the name of the desired object, enter it in this text box. You can also specify the
first character(s) of the name followed by an asterisk (*) to find all object names that start with
these characters.

If you want to specify more than one name, click the Choose button which is shown next to
the Name text box. The Names dialog box appears. See the example below.

Namespace

For objects of type Field only. Enter the name of a file. Asterisk notation is possible.

Example - find more than one object type:

The following dialog box appears.
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"¢’ Choose Dbjecttypes

hoose Objecttypes

[ Database .
D Dataspace

[ Extract

1 Field

[ Fil=

[ File relation

] Hb_test

[ interface

[ keyword

[ Library structure

] Method

] nmetwork

] Mode

[ Packagelist

Program

D Property

] Report listing e
D Server

D Skoragespace

D Svskem

D Trigoer ll

Select Al | Deselect .ﬁ.lll

) ok | Cancel

Example - find more than one type:

The following dialog box appears for object type Program.
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e |

Choose Type:

Message File

Class

Fesource

Adapker

Parameter Data Area

Copy Code

Documented

Exkernal Program

Function

ialobal Daka Area
Helproutine

D niannic

Job

ISPF Macro

Local Daka Area

Map [/ Helpmap

Subprogram

Matural Command Processor
Programm

S0L Procedure ll

REREEEERERREEEEREREEREEE

Select Al | Deselect .ﬁ.lll

) ok | Cancel

The currently defined types are selected. You can now select the required types, or deselect the
types that are not to be considered in your search. Choose the OK button to close the Types dialog
box. On the Identification tab, the selected types (as much as fit in the text box) are now shown
in the text box of the Type drop-down list box.

Example - find more than one name:

The following dialog box appears when click the Choose button next to the Name text box. When
names have already been defined, they are shown in the dialog box.
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N |

Marmes

abc*
xy2*|

ik

Cancel

You can enter the names or the first character(s) of the name(s) followed by an asterisk (*). Choose
the OK button to close the Names dialog box. On the Identification tab, the specified names (as
much as fit in the text box) are now shown in the text box of the Name text box.

Contents

You can search for objects that contain specific text.
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7= Find Documentation Dbjects

e

|5|:Ivanced Object Type Specific I

Conkaining bexk: | v Igniore case
v absolute
Scope
[ abstract [ Rules
r Descripkion [ Mame
.;:-E;. (8]4 Cancel
Option Description

Containing text

Specify the text. The check boxes on this tab are only available when you have entered
text in this text box.

Abstract If selected, the abstract is searched for the specified text.

Description If selected, the extended description is searched for the specified text.

Absolute If selected, embedded text strings are found (for example, the embedded text string "mari”
in "primarily"). If not selected, only occurrences of the search string that are delimited by
blanks or special characters are found.

Rules If selected, rules are to be scanned for the search string. This option applies exclusively
to verifications. With objects of other types, this check box is disabled.

Name If selected, objects will only be selected if the specified text occurs in the name (object ID).

Ignore case

If selected, no distinction is made between upper-case and lower-case characters.
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Advanced

You can search, for example, for objects which contain specific keywords or which have a specific
owner.

7= Find Documentation Dbjects H=] E3
Identification I Conkents | Chject Type Specific I
~Keywords
with: | Select...
@« anp | Select, ..
Cor | Seleck, ..
| Select...
| Select...
But MNOT: | Select...
Witk Cianier s | Select. ..
Inchuded in Exkrack: I Select. ..
Creation | Madification Date
™ From Date I 4i12/2010 ﬁ Calendar | I From Time I &:04 P j
™ ToDate | 4j1zjz010 = Calendar [ TaTime | 6ipdpm ==
[:‘E] Ik Cancel

Option Description

With Only objects with the given keywords are included in the selection. Up to five keywords
can be specified. Asterisk notation is possible.

AND/OR When the option button AND is selected, the object must contain all specified keywords.
When the option button OR is selected, the object must contain one of the specified
keywords.

But NOT Objects with the given keyword are excluded. Asterisk notation is possible.

With Owner Only objects with the given owner are included in the selection. Asterisk notation is
possible.
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Option

Description

Included in Extract

Only objects contained in the specified extract are included in the selection. With
asterisk notation you can specify a range of extracts.

From Date/Time

Only objects that were added or modified on or after this date will be selected. If a
modification date exists, this will be evaluated. If no modification date exists for an
object, the creation date is evaluated. Format "MM/DD/YYYY" for the date and "HH:II"
for the time. You can also click on Calendar or use the arrow buttons to specify a
certain date or time.

To Date/Time

Only objects that were added or modified on or before this date will be selected. If a
modification date exists, this will be evaluated. If no modification date exists for an
object, the creation date is evaluated. Format "MM/DD/YYYY" for the date and "HH:II"
for the time. You can also click on Calendar or use the arrow buttons to specify a
certain date or time.

Object Type Specific

The search options on this tab depend on the object type that has been selected on the Identification
tab. This tab does not appear for all object types or if more than one object type is selected. Example

for programs:
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_'q- Find Documentation Objects [Program]

Identification | Contents | Advanced  Object Type 5pecific|

Language:

Member:

Library:

ser system FRR.:

Iser system DEnr:

Class Mame:

Version:

File name:

specific name:

Enkry points:

Procedure name:

Function name:

!
!
|
!
|
!
Global Unique Identifier: I
!
|
!
|
!
!
!

Schema name:

(7l I Cancel

Specity all required search options.

Displaying the Properties

In Predict Description and Generation, the properties for the selected node are automatically
shown in the standard Eclipse Properties view (Show View > Other > General > Properties).

In this view, the context menu provides the Copy command, which can be used to copy the content
of the selected row to the Clipboard.

Different property information is shown, depending on the selected node:

40 Predict Description and Generation



Invoking an Overview of All Documentation Objects

* Top-level Documentation Objects node
You can see the information that was specified when the connection was created and the version
of Predict which is installed in the remote environment and the FDIC database ID and file
number.

You can see whether a filter is active (Y/N). See also Defining the Object Types to be Shown.

Propert Yalue
FDIC=(180,250)
Filker active i
Hosk ibrnz
Port 4722
Session Parameters  profile=(prd4a, 177, 7 Fdic=(180,250)
Title Docurnentation Objects
User ID HMOD

® Node for an object type
You can see whether a filter exists and whether it is active (Y/N). See also Applying a Filter to
an Object Type.

PmEEH:E ’ Walue ’

0 DaTABASE
Title Database

® Node for an object of a specific type
You can see when and by whom the object has been added and, if applicable, last modified.
When an abstract has been specified, it is also shown.

Property | Yalue |
Abskract asdgsdgdsf
fdded Z009-08-13 15:01
Modified 2009-05-31 15:00
Marne
Skatus Cbject
Twpe S0L Server
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" Node for an association
You can see name, source, destination and direction, and when and by whom the association
was added and, if applicable, last modified. When an abstract has been specified, it is also shown.

Property | Yalue
ahstrack
fdded 2009-11-25 09:51
Destination File
Direction active

| Modfied [ |
Mlarne Contains File
Source Database
Refreshing the Tree

You can refresh each node of a connection, so that the latest changes to the documentation objects
are available in the Predict Description and Generation view. When you refresh a node, only the
subtree of this node is refreshed.

@ Caution: For external objects, a command with a similar name, Refresh External, is available.

Do not confuse this command with the Refresh command. See Refreshing an External Object
for further information.

> To refresh the tree

1  Select the node that you want to refresh.

2 Invoke the context menu and choose Refresh.
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= Redocumenting Natural Objects ..................
= Displaying the Description for a Natural Object
= Opening the Description for a Natural Object .
= Reporting the Description for a Natural Object

43



Managing Natural Objects

Redocumenting Natural Objects

You can create documentation objects for Natural objects that are shown in the Natural Server
view, in the Project Explorer view or in a Natural Editor.

The following restrictions apply for Natural objects:

® Currently, it is only possible to redocument Natural sources which reside on the server side.
® DDMs and Libraries in the Project Explorer view are not supported.

This feature uses the defaults for the redocument function that have been defined in Predict. The
results of the redocument function are shown in the Predict report view.

The Predict processing option "Add and Replace" is always used. This means: a documentation
object of type Program is created for the selected Natural object. Or, when a library has been selec-
ted, documentation objects of type Program are created for all Natural objects in this library. Ex-
isting documentation objects are replaced.

It is also possible to create documentation objects in a different way. See the sections Opening the
Description for a Natural Object and Adding a New Documentation Object for further information.

> To redocument a Natural object

—_

Select the Natural object in the Natural Server view or in the Project Explorer view or in a
Natural Editor.

2 Invoke the context menu and choose Predict Description and Generation > Redocument.

~ To redocument all Natural objects in a library with a specific type

—_

Select the type node (for example subprograms) in the Natural Server view.

2 Invoke the context menu and choose Predict Description and Generation > Redocument
Objects.

~ To redocument all Natural objects in a library

—_

Select the library in the Natural Server view.

2 Invoke the context menu and choose Predict Description and Generation > Redocument
Objects.
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Displaying the Description for a Natural Object

Using the Display Description command, you can display information on a documentation object
for a Natural object, DDM or library.

When a documentation object does not yet exist, a warning appears in the result window indicating
that the object is not documented.

When a documentation object does already exist, an object type-specific window appears and you
can view the defined information. This is the same window which appears when you open the

description for a Natural object, DDM or library (see below). The only difference is that the inform-
ationis provided in read-only mode and that certain command buttons are therefore not available.

Note: DDMs on platforms running Natural for Windows or Linux are only supported, if

they reside in library SYSTEM or the Natural system file respectively, for DDMs are defined
via the Natural profile parameter FDDM.

~ To display the description for a Natural object

1

Select the Natural object in the Natural Server view or in the Project Explorer view or in a
Natural Editor.

Invoke the context menu and choose Predict Description and Generation > Display Descrip-

tion.

When a documentation object does already exist, a window for the object type Program ap-
pears. See Program in Predefined Object Types in Predict for further information.

In case of a DDM, a window for the object type File appears. See File in Predefined Object Types
in Predict for further information.

In case of a library, a window for the object type System (system type Application Library)
appears. See System in Predefined Object Types in Predict for further information.

Choose the OK button to close the window.
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Opening the Description for a Natural Object

The implementation pointer is used to establish the connection between the Natural object and
the documentation object. In case of a Natural object it consists of member name, library name,
user system file number and user system database number. When you open the description for a
Natural object, the best hit principle is applied: the member with the most detailed implementation
pointer is shown. So that a matching documentation object can be found, at least the member
names must match. Exception: in case of a DDM an implementation pointer does not exist; the
connection is established via the name.

In case of a library, the implementation pointer consists of library name, user system file number
and user system database number. So that a matching documentation object can be found, at least
the library names must match.

If no documentation object is found for the selected Natural object, you will be asked whether you
want to redocument the selected object. This dialog is only displayed in the Natural Server view.

7= Predict Description and Generation

::/) Cbject not documented, Do wou want to redocurnent this Object?
-

When a documentation object can be found, you can modity it.

| Note: DDMs on platforms running Natural for Windows or Linux are only supported, if

they reside in library SYSTEM or the Natural system file respectively, for DDMs are defined
via the Natural profile parameter FDDM.

~ To open the description for a Natural object

1  Select the Natural object in the Natural Server view or in the Project Explorer view or in a
Natural Editor.
2 Invoke the context menu and choose Predict Description and Generation > Open Description.

A window for the object type Program appears. See Program in Predefined Object Types in Predict
for further information.
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In case of a DDM, a window for the object type File appears. See File in Predefined Object Types
in Predict for further information.

In case of a library, a window for the object type System (system type Application Library)
appears. See System in Predefined Object Types in Predict for further information.
Specity all required information. See also Object Type-Specific Windows.

Choose the Save button to modify the documentation object.
Or:

When you save a new object and a name has not yet been specified, the Save As dialog box
appears. In this case, you have to specify a name for the new documentation object and choose
the OK button.

Reporting the Description for a Natural Object

Using the Report Description command, you can find out whether a documentation object already
exists for a Natural object, DDM or library.

When a documentation object does not yet exist, a warning appears in the result window indicating
that the object is not documented.

When a documentation object already exists, the Predict Report view appears. The report provides
information on the documentation object in simple text format..

Note: DDMs on platforms running Natural for Windows or Linux are only supported, if

they reside in library SYSTEM or the Natural system file respectively, for DDMs are defined
via the Natural profile parameter FDDM.

~ To display the description for a Natural object as a report

1

Select the Natural object in the Natural Server view or in the Project Explorer view or in a
Natural Editor.

Invoke the context menu and choose Predict Description and Generation > Report Descrip-
tion.

The report description is displayed.

See also Printing and Saving a Report for a Documentation Object for details.
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8 Managing Documentation Objects

= Object Type-Specific Content Editors ...........cccceeeeein
= Adding a New Documentation Object .............cccoeeenne.
= | ocking of Documentation Objects ..............c.cccuvveennne.
= Opening/Displaying an Existing Documentation Object ...
= Renaming a Documentation Object ................cccvvvveee.
= Purging a Documentation Object ..............coovvviiieinnn,

= Printing and Saving a Report for a Documentation Object
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Object Type-Specific Content Editors

An object type-specific content editor appears when you open an existing documentation object,
or when you add a new documentation object.

The object type-specific content editors have different tabs with different types of edit controls.

= Tabs

= Simple Edit Controls
= Text Box

= Text Editor

= Tables

= Saving Your Changes

Tabs

Two types of tabs are available:

® Common tabs that are always the same for all object types are Overview and Extended Descrip-
tion. See Global Attributes in the reference documentation Predefined Object Types in Predict.

® Tabs that are only shown for this type of object. See the object type-specific descriptions in the
reference documentation Predefined Object Types in Predict.

The tabs are shown at the bottom of the content editor. When more tabs are available than can be
shown on the screen, a number at the bottom right indicates that there are more tabs. When you
select this number, you can display a tab by choosing its name from a list.

Screen 2| e ||

* fdabas Database Attribukes
Ass0 Sizes

nil

Datka Sizes

hark [ Temp Sizes
Universal Encading Support
Q5400 Attribukes

Several tabs require that you specify mandatory information. Such a tab shows an asterisk (*) next
to the tab name.

50 Predict Description and Generation



Managing Documentation Objects

Simple Edit Controls

Some tabs provide simple edit controls such as text boxes, check boxes or drop-down list boxes.

For the description of check boxes, the reference documentation Predefined Object Types in Predict
uses the abbreviations Y (yes) and N (no). Y means that the check box is selected, and N means
that the check box is not selected.

Text Box

Some tabs such as the Overview tab provide a simple text editor such as the Abstract section. Edit
commands like Copy and Paste are available in a context menu. Example:

* [dabas Database] &3 = O
- e
Overview @
General » Keywords laz
Marne:
r Owners la
Twpe: Adabas Database z
Added:
Modified:
w Mandatory Association
* Belangs ko VML LI

Enter an optional abstract providing short comments on the object.

=

o o

Overview | Extended Description | Adabas Database Attributes | Sizes | *User_Defined_Tab
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Text Editor

The following tabs provide a text editor:

® Extended Description,
" Processing Rule (of a verification),

Check Expression (for files of type DB2 Table),

Subquery (for files of type DB2 View) and
Field Expression (for a DB2 View Field).

Using the commands from the common Edit menu, you can Cut, Copy, Paste, Delete, Select All
and Find/Replace text. In addition, you can undo and redo your last change and make a Revert
File operation.

The above commands are available using the corresponding Eclipse keyboard shortcuts.
Some of these commands are also available when you invoke the context menu in the editor.
When using the editor the following functions are available:

® The function Show line numbers in the Eclipse Preferences can be switched on/off in the editor.

~ To display the Text Editors preferences from within the text editor

1  Onany column in the editor, invoke the context menu and click on the Preferences option.

The Text Editors preferences menu is displayed.

2 Activate/deactivate the Show line numbers option.
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7= Preferences (Filtered) M=l E3

= General
&l Editors
- Text Editars

Text Editors - - -

lUndo histary size: 200

Displayed tab width: I 4

[" Insert spaces for kabs
I Highlight current line
™ shaw prink margin
Primt rmargin colurnr; ISD—
[ Show line numbers
¥ Show range indicator
[ Show whitespace characters

W Show affordance in hover on how to make it sticky

When mouse moved inko howver: |Enrich after delay j
¥ Enable drag and drop of bext
¥ warn before editing a derived File

¥ Smart caret positioning at line start and end

Appearance color options:

Line number Foreground Color: [ |
Current line highlight

Prink margin

Find scope

Selection Foreground color

Selection backaround color

Background color

Foreground calar

Hyperlink

Mare colars can be confiqured on the Caolors and Fonks preference page.

Restore Defaults | Apply |
@) oK I Cancel |
3  Click OK.

The text editor now displays/hides line numbers.

® The function Go to line is available via the Eclipse keyboard shortcut ctri+L. The following dialog

is displayed:

Predict Description and Generation
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_I-p Go to Line E |

Enter line number (1,24

(514 Cancel

® The Eclipse Status Line shows whether the object is ("Writable" or "Read-Only"), the editor’s
insert mode ("Smart Insert" or "Overwrite") and the current cursor position (following the pattern
"line : column").

Writable smart Insert 9:1

A double click on the status field insert mode toggles this mode.

A double click on the status field cursor position opens the above Go to Line dialog.
Tables

Some tabs provide tables to which you can add new information. A table may contain one or more
resizable columns. Example:
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] * [Adabas Database] &3

E Sizes @

+ Asso sizes specification » DATA sizes specification

Teiine I mumber of RAEM I b Sort sizes specification

Remowve

¥ Work sizes specification

¢ Temp sizes specification

Civeryiew |Extended Description |.ﬁ.dabas Database Attributes | Sizes *User_DeFined_Tab|

The following command buttons are provided with a table:

Command Button | Description

Add... Creates a new row containing several cells in which you can enter information.

Remove Removes the selected row.

The following functions are provided in the context menu of a table:

Command Button | Description

Insert Creates a new row containing several cells in which you can enter information.

Delete Deletes the selected row.

To modify existing information in a cell of the table, simply overwrite it. You can either enter in-
formation directly in a cell or select it from a drop-down list box.
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Saving Your Changes

To save your changes in an object type-specific content editor, you simply use the Eclipse save
functionality.

] Notes:

1. When you save a new object and a name has not yet been specified, the Save As dialog box
appears. In this case, you have to specify a name for the new documentation object and choose
the OK button.

2. When mandatory information has not been specified, an appropriate error message is shown
in a dialog box. The tab on which information is missing is automatically shown. The document-
ation can only be saved after all mandatory information has been specified.

Adding a New Documentation Object

You can manually add documentation objects for all predefined and user-defined objects types
in Predict. You have to specify all information yourself, including the implementation pointer.
This function is helpful, if documentation is to take place before implementation. Information on
the implementation pointer can be found under Opening the Description for a Natural Object.

~ To add a new documentation object

1  Select the object type for which you want to add a new object.

2  Invoke the context menu and choose New.
In some cases, you have to select a type (for example, a database type) in a dialog box. The
resulting content editor then shows object-specific information.

3  Specify all required information as described in the reference documentation Predefined Object
Types in Predict. See also Object Type-Specific Content Editors.

Locking of Documentation Objects

When a documentation object is modified, renamed or deleted, it is automatically locked to prevent
concurrent updates.

When working with associations and links, the following applies:

® When the Unlink/Link command is used, the parent object is locked. See also: Linking and
Unlinking Associations.
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® When the Attributes of Link command is used, both the parent and child object are locked. See
also: Modifying the Attributes of a Link.

@ Caution: Currently, locking of documentation objects is only possible on the client side when

using Predict Description and Generation. When performing actions on documentation
objects in Predict on the server side, the locking mechanism is ignored. This can result in
inconsistent data.

When a system interruption has occurred, you can manually unlock locked documentation objects.

A\  Important: You should only unlock a documentation object when you are sure that this object

is currently not being edited by another user.

~ To unlock a documentation object

1  Select the documentation object that you want to unlock.

2 Invoke the context menu and choose Unlock Object.

Opening/Displaying an Existing Documentation Object

When you open a documentation object, it is possible to modify it (edit mode). There is one excep-
tion: when the documentation object is currently locked, it is only possible to view the information,
it is not possible to modify the documentation object (read-only mode).

~ To open a documentation object

1  Select the documentation object.

2 Invoke the context menu and choose either Open or Display.
Or:
Double-click the documentation object.

An object type-specific content editor appears. See also Object Type-Specific Content Editors.
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Renaming a Documentation Object

You can change the object ID with the Rename command. The new object ID must not already
exist in the dictionary.

~ To rename a documentation object

1  Select the documentation object that you want to rename.

2  Invoke the context menu and choose Rename.

A dialog box appears prompting for a new name.

3  Specify another name and choose the OK button.

Purging a Documentation Object

You can purge documentation objects using the Delete command.

For further information on the purge process, see the object type-specific descriptions in the refer-
ence documentation Predefined Object Types in Predict.

~ To purge a documentation object

1  Select the documentation object that you want to purge.

2 Invoke the context menu and choose Delete.

A dialog box appears asking whether you really want to delete the object.

3 To confirm the deletion for the current object, choose the OK button.

Printing and Saving a Report for a Documentation Object

The information shown in an object-type specific window (which can be invoked with the Open
or Display command) can also be shown as a report in simple text format. It is possible to print
and save this report.

~ To print and save a report

1  Select the documentation object.

2 Invoke the context menu and choose Report.
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A window such as the following appears.

[[] HEB-# [Adabas Databass] 23

Hame:
Type:

Added:
Modified:

Abstract
aaa
net
5855855852283 0 D0 DDEDDDSSa82858

Extended description

Handatory A=sociation
Belong=s to VM

Adabas Database Attributes

General Attributes
Run mode
Fhy=ical database number
Hazimal files
Checkpoint file
Adabas =ecurity
Size of RAEN
Distr. transaction
Vista access only
05-400 Attributes

Database namne

Hatural file numbers
Sy=tem file (FHAT)
HAT-Security (FSEC)
Predict (FDIC)

Universal Encoding Support

TES

I3

HEE-4

Adabas Database
2009-04-23 14:12
2009-11-30 17:07
HCOHE

I - Isolated
1=

a
a
a
0 — not specified
H - Ho

H

by
by

Prink | Save |

3  Choose the desired command button:

Command Button | Description

Print The Print Setup dialog box appears. Specify all required information (for example,
a different printer or text orientation) and choose the OK button.
Save The Save Report dialog box appears. Select the folder in which you want to store the

report, specify a report name and choose the Save button.

4 To close the window in which the report is shown, choose the OK button.

Predict Description and Generation
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9 Managing Associations and Links

= Linking and Unlinking Objects ............cccovveeiiiinienns
= Modifying the Attributes of a Link ............ccccccovinienns

= Printing and Saving a Report for the Attributes of a Link
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Linking and Unlinking Objects

You can link more objects to a parent object or remove linked objects. You can also modify the
sequence of the linked objects.

~ To link and unlink objects

1  Select the node for the desired association in the tree.

2 Invoke the context menu and choose Unlink/Link.

| Note: There are several associations for which it is not possible to change the list of

linked objects. The Unlink/Link command is dimmed in these cases. An example of
such an association is "Has Fields"; fields can only be maintained via the object type-
specific content editors which appear for files and fields.

A window appears. The name and type of the parent object and the name of the association
are shown in the title bar. A list of linked objects (children) is shown on the right side of the
window.

* . AAM-ADA [Adabas Database] Contains File

Mot linked [0] rLinked [3]
File | File: | Phys, file number | Phs, distributi.. . |
SU-180-3 3
SAG-ADA-CHECKPOINT k]
SAG-ADA-SECURITY 344

X ER N

o

Find | Mew | Up | Diown |
() ok | ool | conv |

3 Use the following command buttons to link/unlink objects:
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Command Description
Button
Find Invoke the Find Documentation Objects dialog box in which you can specify the

search criteria for the objects that are to be shown on the left side of the window. Found
objects can then be moved to the list of linked objects. For information on the Find
Documentation Objects dialog box, see Finding Documentation Objects.

> Move the objects that are currently selected on the left side of the window to the list
of linked objects on the right side of the window. See also the description of the Find
button.

< Remove the linked objects that are currently selected on the right side of the window.
When a linked object has been removed, it is shown in the list on the left side of the
window.

>> Move all objects from the left side of the window to the list of linked objects on the
right side of the window.

<< Remove all linked objects on the right side of the window.

New Add a new object to the list of linked objects. A dialog box appears in which you have
to enter the name for the new object.

Up Move the selected linked object one position up in the list.

Down Move the selected linked object one position down in the list.

4 Choose the OK button to saves all changes and to close the window.

Modifying the Attributes of a Link

This function is only available for links where attributes have been defined for the corresponding
association in the metastructure of the Predict data dictionary. With the predefined associations
this is the case, for example, for the links "Has Files" of an Adabas database, and for the links
"Defined in Server" of a DB2 database or file. With user-defined associations, attributes may also
be defined. When such attributes have been defined, it is possible to add or modify their values
for a link.

~ To modify the attributes of a link

1 Open the node for the desired association in the tree.
2 Select the desired documentation object.
3  Invoke the context menu and choose Attributes of Link.
Adabas databases and files only:
When the logical distribution type "Expanded" or "Partitioned" has been defined, the fol-

lowing Link dialog box appears in which you have to select the link to be modified. A
number in the Phys. file number column stands for the physical file number.
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" 0190 [adabas Databasel Cotamsrie
r—Mat linked [0] rLinked [7]
File: | File: | Phys. file number | Phys. distributi... |
SAG-ADA-LOB 11
EMPLOYEES-FILE 67
SMR-CITY GUIDE I
SMR-16 16
SAG-ADA-CHECKPOINT 1
SAG-ADA-SECURITY 2
CHD-A-MUPER 10

<

Ay x v

Find | Tew | Up | Down |
(7 QK I Cancel | Apply |

When the Link dialog box has been invoked using the Unlink/Link command, it is also
possible to add a new link by selecting New. Choose the OK button to proceed to the as-
sociation-specific content editor (see below).

The tabs that are shown in the resulting content editor depend on the type of association. See
the reference documentation Predefined Object Types in Predict for further information.

The following is an example of an association-specific content editor in which the attributes
of the link can be modified.
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-,

. o |
|| DE180 [Adabas Database] Contains File CHO-A-FILE [Adabas Da 52 B

= Overview

General Information

Aadabas Database DEB1S0

Adabas File i_HD-A-FILE
Added 2003-02-07 16:13 by SMR
Modified 2003-12-03 14:27 by SMR

a | |

CrvErview | Base Attribukes | Security [ADAMEncodings | Extent Allocation |

When an object is locked, a corresponding message is shown and the attributes are shown in
read-only mode.

Printing and Saving a Report for the Attributes of a Link

The information shown in an association-specific window (which can be invoked with the Attributes
of Link command) can also be shown as a report in simple text format. It is possible to print and
save this report.

~ To print and save a report

1 Open the node for the desired association in the tree view window for the documentation
objects.

2 Select the desired documentation object.

3 Invoke the context menu and choose Report Attributes of Link.

A window such as the following appears.
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Databa=se
Contains Fil
File

|
Added:
Modified:

Base Attribute
General Attr
FPhyv=. file
Min ISW
Adzzociated
Ho BT file
Max ISW
Max recl.
ISH reusag
U==r ISH
One AC ext
L[S reusage
ISH Size
Hized DS d
Ciphered

PLOG
Erasze

I

[“F] DE180 [Databass] Conkains File CHO-A-FILE [File] 53 =8

Length Cwner ID
Fefresh from progran
Automatic allocation

Index compression
Default allocation

Device
&S50 3390
DATA 3390
Size in Blocks
I 12
NI 12
D5 1
Fadding Factor
&S50 10

DE180 -
=
CHD-A4-FILE

2008-02-07 16:13 by SHR
2008-12-03 14:27 by ESHR

=
ibutes
number

=

LOB file nunber

fr
=1

=
ent

- 3 bvte ISN (~370 VHS)

evice

EEmEmm oMo EnnooEZor

-
2
Prink | Save |

4 Choose the desired command button:

Command Button

Description

Print The Print Setup dialog box appears. Specify all required information (for example,
a different printer or text orientation) and choose the OK button.
Save The Save Report dialog box appears. Select the folder in which you want to store the

report, specify a report name and choose the Save button.

5 To close the window in which the report is shown, choose the OK button.
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Generating an EXternal ODJECE ...........viiiiiiiiie e
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Refreshing an EXternal ODJECT .........ooiiiiiiiii e
Disconnecting an EXternal ODJECL ..........cooiiiiiiiiiii e

Purging an External Object
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Generating an External Object

You can generate an external object from a documentation object.

~ To generate an external object

1  Select the documentation object for which you want to generate an external object.
You can generate an external object from the following object types:

* DB2 databases

® dataspaces

* files of many different types

" programs of type database function and SQL procedure
"= storagespaces

= verifications of type automatic

2 Invoke the context menu and choose Schema Generation Wizard.

The schema generation wizard appears.

3 Specify all required options. If available choose the Next button to proceed to the next page.
For detailed information on the object type-specific information that can be specified using
this wizard, see Generation of External Objects in External Objects in Predict.

4  If all required information has been specified, choose the Finish button to start generation.
When the generation process has completed, the last page of the wizard is shown. When the

List option has been selected on a previous page of the wizard, a report is shown. If an error
occurs during the generation process, an error report is shown.

Incorporating External Objects

This section describes the wizard that is used for schema incorporation.

The wizard provides several pages in which you have to specify information. The number of pages
and the information on these pages depends on the object type that has been selected on the first
page of the wizard.

For detailed information on the object type-specific information that can be specified using this
wizard, see Incorporation in External Objects in Predict.

68 Predict Description and Generation



Managing External Objects

The wizard uses edit controls such as text boxes, check boxes or drop-down list boxes. For the
description of check boxes, the reference documentation External Objects in Predict uses the abbre-
viations Y (yes) and N (no). Y means that the check box is selected, and N means that the check
box is not selected.

~ To incorporate an external schema

1  Inthe Natural server view, choose Predict Description and Generation > Schema Incorpor-
ation Wizard.

Or:

In the Predict Description and Generation view right-click on the root node and select Schema
Incorporation Wizard

The schema incorporation wizard appears, providing several pages.
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7= Schema Incorporation Wizard _ (3] <]
Object Type Selection -
First of all yvou have ko dekermine the external object type wou want to incarporate, ﬂ

3

adabas Database

l

DBZ Database
DEZ Storagegroup
DEZ Tablespace
DEZ Tableview

5 N i i

(7 = Back: Mext = Firish Zance|

| Note: If DB2 is not installed at your site, the incorporation functions for DB2 objects
are not available.

2 Select the option button for the type of external object that you want to incorporate.

3 Choose the Next button to proceed to the next page.

The information on the next pages depends on the object type that has been selected on the
first page.
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Example - incorporate Adabas file:

_I- Schema Incorporation Wizard =]

Object Selection Criteria W

—Selection Criteria for &dabas File

Diakabase number 150

|

Pheesical File number from | 1
Lo 255

Even if only FOT exists  jiv

&dabas password I

() = Back

Eimish Cancel

4  Specify the selection criteria and choose the Next button to proceed to the next page.
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Example - incorporate Adabas file:

_I-' Schema Incorporation Wizard =]

FPhysical Object Selection W

wou now have to determine the physical object wou wank ba incorporate.

—Please select an Adabas File

PFrr: 4, Adabas name: HEBCMX_IMDEY, Predict file: SAG-A0A0-LOE

FFnr: 5, Adabas name: SMR-TEST-GEM

PFnr: 6, Adabas name: SU-18000-11, Predict file: HEE-A-1

FFor: 7. Adahas name: SI1-180-7 I ,
4

« vl

(7] = Back Mext = Eimish Cancel

The incorporation functions that are available on this page depend on the object type that has
been selected on the first page.

5  From the drop-down list box, select the object that you want to incorporate.

When an object has been selected, the option button(s) for the incorporation function(s) that
can be executed for this object are visible.

For general information on these buttons, see Overview of Incorporation Options in External
Objects in Predict.

6  Select the option button for the incorporation function that you want to execute (Incorporate,
Connect or Test) and choose the Next button to proceed to the next page.
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An additional page appears when you have selected the incorporation function Incorporate
or Connect. You can then specify the incorporation or connect options.

Example - incorporation options for an Adabas file:

_I- Schema Incorporation Wizard =]

Options W

— Incorporation Options for &dabas File

File: 1D I SMR-TEST-GEMN

* File attributes IR - "'I

Field name prefix: |

Field name sufFix |

List incorporated code F

Einizh Cancel

| Note: Different options or pages appear for the incorporation functions Connect and
Test.

7 Specify the required information and choose the Next button to proceed to the next page.
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Example - incorporate Adabas file:

_I- Schema Incorporation Wizard =]

Command -
The Following cormmand will be processed, Only parameters different to defaul: ﬂ
walues are shown,

THCORPORATE AF ﬂ
SUB-FUNCTION=I

FEOM-FHE=5

TO-FHE=5

FILE-ID=SMR-TEST-GEN

4 Ne

Mext = Einizh Cancel

This page shows only the settings which have been modified on the previous pages.

8 Ifall required information has been specified, choose the Finish button to start incorporation.

| Note: Aslong as you do not choose the Finish button, you can go back to the previous

pages by choosing the Back button.

When the incorporation process has completed and the List incorporated code option has
been selected previously, a report is shown in a separate Predict Report view. If this option
has not been selected, a message box shows only the resulting message of the incorporation
process.
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However, if an error occurs during the generation process, an error report is shown in the
Predict Report tab. The error report is always shown. The setting of the List incorporated
code option is not considered in this case.
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Example - incorporate Adabas file:

| -
INCORPORATE AF
SUB-FUHCTION=I
FROM-FHR=8

TO-FHE=§
FILE-ID=5U-ADA

List of attributes incorporated for file: SU-ADA
Fnr: 8 DBnr: 180

Adaba= name ... ... ... ... SO-ADA

Diztribution type ....... Simple file

Az=zo—-Padding-Factor ... .. gooooooolo _J:J
A »

You can Print the report on a printer that is defined in your environment or Save it using the
standard Eclipse functions of the File menu .

Refreshing an External Object

You can refresh Adabas files and DB2 tables/views. When you refresh such an external object, you
delete all of its contents.

See Administration of External Objects in External Objects in Predict.

@ Caution: Do not confuse this type of refresh (this term is used with Adabas) with the refresh
function which updates your display see Refreshing the Tree.

~ To refresh an external object

1 Open the External Objects node containing the external object that you want to refresh.
2 Select the external object.

3  Invoke the context menu and choose Refresh External.

| Note: When the refresh function is not available for the selected external object, the
Refresh External command is disabled.

A dialog box appears asking whether you really want to refresh the object.
4  To refresh the current object, choose the OK button.
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Disconnecting an External Object

When you disconnect an external object from its corresponding documentation objects, the imple-
mentation pointer from the documentation object to the external object is deleted, but the object
itself remains intact.

See Administration of External Objects in External Objects in Predict.

~ To disconnect an external object

1  Open the External Objects node containing the external object that you want to disconnect.
2 Select the external object.

3  Invoke the context menu and choose Disconnect.

A dialog box appears asking whether you really want to disconnect the object.

4  To disconnect the current object, choose the OK button.

Disconnected external objects are no longer shown in the External Objects node.

Purging an External Object

You can purge external objects using the Delete command. When you purge an external object,
it is disconnected and physically deleted.

See Administration of External Objects in External Objects in Predict.

> To purge an external object

1 Open the External Objects node containing the external object that you want to purge.
2 Select the external object.

3  Invoke the context menu and choose Delete.

A dialog box appears asking whether you really want to delete the object.

4  To confirm the deletion for the current object, choose the OK button.
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Managing Predict Components

Predict Components enable an easy way of distribution and versioning of DB assets (Adabas
DDMs and files (FDTs) based on Predict definitions) for continuous integration and deployment.

How is it used?

Perform the steps as described in:

= Steps required in Predict
= Steps required in your Natural Project(s)

Steps required in Predict

~ To create and manage Predict components

1

In the Predict Description and Generation tab expand the File node and either modify existing
or create new file(s).

To modify existing file(s) select the file(s) to be modified and right-click on your selection.

To create new file(s) right-click on the File node and from the context menu choose New.

Modify or create an extract that contains the artifact that you want to have in your project in
the Project Explorer view.

To modify existing extract(s) select the extract(s) to be modified and right-click on your selec-
tion.

To create new extract(s) right-click on the Extract node and from the context menu choose
New.

To import objects into the extract(s), choose the Import button.
A standard find dialog appears.

After your selection the import dialog opens from which you can choose the objects to be
imported into the extract(s).
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Steps required in your Natural Project(s)

~ To create and manage Predict components

1  Create new Predict Components folder:

In the Project Explorer view, right-click on the project folder where you want the Predict
Components folder to be created. In this example, the project is named "Development".

Optional Batch Deploy:

In each Predict Component folder an ant batch file (prf_deploy.xml) and a directory named
plugins with the *.jar-files for batch deploy is created.

The following commands are available:
help display command
unload  unloads extracts (uses the *.ULD Files)

Toad loads the contents of the extracts (uses the *.PRD Files)
generate generates the Predict Objects (e.g. Adabas File) (uses the *.GEN Files)

=]

Create a Predict Components Folder

Create a new folder rescurce,

Enter or select the parent folder:

| Development

(=
= Development->daef-7201 (1)
= Production->daef-7201 (1)

Felder name: | Predict Components

Advanced >»
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The default name for the Predict Components folder is also "Predict Components". You can
alter the name in the Folder name field.

2 Unload the artifacts from your Predict environment.
In the Project Explorer view, right-click on the Predict Components folder.
In the context menu click on Predict Components > Unload.
Various files will be created based on your Predict environment to the Predict Components
folder.
Files with a *.GEN suffix contain commands for the Predict Generation.
Files with a *. PRD suffix contain the artifact data for the Predict Load.
Files with a *.ULD suffix contain the names of extracts for the Predict Unload.
3  Modity and/or adapt the list of files offered in the Unload Predict Components wizard ac-
cording to your requirements and press Finish.
|
Unload Predict Components
Specify a extract list
File Name:
| DEMO-EMPLOYEES
Extract List:
DEMO-EMPLOYEES
Extract List(Cemma separated):
<extract 1=, ..., <extract n»
A successful Unload will result in a UNLOAD TERMINATED SUCCESSFULLY message being dis-
played in the Console view.
4  This step is optional.
After unloading all files, add the project to a repository of your choice, e.g. GIT.
82 Predict Description and Generation



Managing Predict Components

Configure Git Repository GIT
1, Folder Development does not exist in working tree, will be created _j_
[J Use or create repository in parent folder of project
Repository: repasitory - ChUsers\ugr\gitrepositony.git ~ | | Create...
Working tree: | Ch\Users\ugrigit\repository |
Path within repository: | Development | Browse...
Project Current Location Target Location

= Develop... Ci/Usersfugr/werkspacel03_OMNE31/Devel...  Ci/Users/ugr/git/repesitory/Development/Development

5 Load the Predict data.
In the Project Explorer view, right-click on the Predict Components folder.
In the context menu click on Predict Components > Load.

Various files will be offered for a Load from your Predict Components folder to the Predict
environment.

6  Modify and/or adapt the list of files offered in the Load Predict Components wizard according
to your requirements and press Finish.
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=]

Load Predict Components
Specify a file list

Folder Mame:

| Predict Components

File List:

DEMO-AUTOMORBILES.PRD,
DEMO-EMPLOYEES.PRD,
DEMO-INVEMTORY.PRD,
DEMO-TRIPS.PRD,

File List{Comma separated):

<file 1=, ..., <file n>

@

A successful Load operation will result in a LOAD TERMINATED SUCCESSFULLY message being

displayed in the Console view.

In the Predict environment, generate the artifacts from the files loaded in the previous step.

In the Project Explorer view, right-click on the Predict Components folder.

In the context menu click on Predict Components > Generate.

Ensure that the files with a *. GEN suffix only contain those commands that you want to gen-

erate.

Fill in the Generate Predict Components wizard and press Finish.

Various artifacts will then be generated in your Predict environment.
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}e'e.='.=_-'=_:::'..Z:*'::'=_".:- O

>
|
Generate Predict Components
Specify a file list

Folder Mame:

| Predict Components

File List:

DEMO-AUTOMOBILES.GEN,
DEMO-EMPLOYEES.GEN,
DEMO-INVEMTORY.GEN,
DEMO-TRIPS.GEN,

File List{Comma separated):

<file 1=, ..., <file n>

A successful generation will result in a GENERATE TERMINATED SUCCESSFULLY message being
displayed in the Console view.
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